panoramlc”

COMPUTER SETUP INSTRUCTIONS

Whether you are upgrading or replacing your current dedicated panoramic x-ray machine computer; please follow these steps to
ensure a successful transition to your new computer.

Panoramic Technical Support can be reached at 800-654-2027 / support@pancorp.com for any questions.

PANORAMIC DENTAL IMAGING

Computer & Software Setup Instructions

for a computer with Windows 10 Professional 64-bit

Used with X-ray Machines:

PC-1000

Digital Upgrade PC-4000



mailto:support@pancorp.com

Pre-Setup - from the existing computer
Backup Calibration Files
Identify capture card
Computer Information

Setup - on the new computer
Verify Computer Operating System & Type
Disable Sleep, Hibernate, & Fast Startup
Install Software - Panoramic Dental Imaging
Install or Configure Drivers for capture card
Verify or Configure Software Settings— Panoramic Dental Imaging
Restore Calibration Files

Adjust Image Appearance

On the existing computer, backup the calib & datastor hidden folders:

Required -- C:\ProgramData\Ajat\panoramic\calib\
Optional -- C:\ProgramData\Ajat\panoramic\datastor\
Note: The datastor folder is used to reload recent images taken. It is not used as a long-term backup.

Alternatively these folder can be accessed from the software under the Tools Menu. If calibration files are not available
on the existing computer due to a computer issue/crash, then a new set of calibrations can be created by having an X-
ray Technician visit your office. Call Support for details.

Image Tools Window Help
Histogi Settings ... |

Dataset tools
DICOM ...

Maintenance ¥ Mechanical alignment ...
Send error report .. Calibration ...

Language N Diagnastics L

Files and Folders > Open log file
Open Log folder
Open Calibration folder
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Type Epix EB1
Expansion PCI Express x1 or x16
Slot (use x16 slot for
Windows 10)
Size Full or Half Height
- call to order different
size bracket
Compatible Windows 7 or 10
Operating 32 and 64 bit
Systems
Used with PC-1000 Digital
Pano PC-4000
Machines
Processor (Intel Brand Required) i5 6th Generation or later
RAM 8 GB
Hard Drive 500+ GB or greater,

7200 RPM or faster

One Available Expansion slot

PCI-Express x16
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From the Start Menu, type “This PC” and click on Properties

Al Apps Documents  Settings Web  More v Feedback
Best match
[y ThisPC
= pop e
Search the web.
This PC

P This PC - See web results > App
Settings (6)

7 Open

<= Pin to Start

= Pin to taskbar

C& Manage

= Map network drive

52 Disconnect network drive

B properties

+
ﬂ L This PC O

o

An Example is shown. Windows 10 Professional, 64-bit Operating System

Control Panel Home . . .
View basic information about your computer

& Device Manager Windows edition

® Remote seitings I Windows 10 Pro for Workstations I

) System protection © 2019 Microsoft Corporation. All rights reserved, .. WI n d OWS 1 0

) Advanced system settings

Systermn
Manufacturer: Dell
Model: Latitude 5480
Processor Intel(R) Core(TM] i3-6440HC CPU @ 2.60GHz 2.60 GHz
Installed memory (RAM): 16,0 GB (15.6 GB usable) m
I Systemn type: 64-bit Operating Systern, x64-based processor I Eﬂ-’;

Pen and Touch: Mo Pen or Touch Input is available for this Display
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a. If PCis windows 10, open the start menu and type “power” click on the “Power and sleep settings”.

I\ Power & sleep settings
System settings

b. On the right side of the window, under Related settings, click “Additional power settings”.
c. On the left side of the window, click “Choose what the power buttons do”.
Near the top of the window click “Change settings that are currently unavailable”.

3 System Settings

&« S @ # Contrel Panel # Hardware and Sound ¢ Power Options »  System Settings w| & Search Contr

Define power buttons and turn on password protection

Choose the power settings that you want for your computer. The changes you make to the SEttiF,\gs on this
page apply toall of vour power plans,

® Change settings that are currently unavailable +—_

Power button settings

e. Uncheck the boxes.
E System Settings

« v A E » Control Panel » Hardware and Sound » Power Options » System Settings v | D Search Con

Define power buttons and turn on password protection

Choose the power settings that you want for your computer. The changes you make to the settings on this
page apply to all of your power plans.

Power button settings

@ When | press the power button: | Shut down ~

Shutdown settings

|:| Turn on fast startup (recommended)
This helps start your PC faster after shutdown. Restart isn't affected. Learn More

Show in Power menu.
[] Hibernate

Show in Power menu.

Lock

Show in account picture menu.




Note: If previously installed, or if this is an upgrade from Windows 7, make sure to uninstall any previous versions of the
program, listed as Panoramic Dental Imaging, or formerly called Ajat Dental Imaging.

Download and Run the software Installation. Panoramic Dental Imaging 9.1.2.7600.exe

Use the Default selections by clicking the Next buttons. Here are the screens to show the prompts.

ﬁ! Setup - Panoramic Dental Imaging had —

Select Components
Which components should be installed?

Select the components you want to install; dear the components you do not want to
install. Click Mext when you are ready to continue.

Full installation with hardware support ~

Cancel

ﬁ! Setup - Panoramic Dental Imaging had - X

Ready to Install
Setup is now ready to begin installing Panoramic Dental Imaging on your
computer,

Click Install to continue with the installation.

< Back Install Cancel

i -
Installing
Please wait while Setup installs Panoramic Dental Imaging on your computer,

Finishing installation. ..

Setup *

Please, install SMAP GigE driver protocol in network adapter
settings and restart computer before using the software,

ﬁ! Setup - Panoramic Dental Imaging had —

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing Panoramic
Dental Imaging, then dick Mext,

Additional icons:

File assodations:

Associate extension .OTZ

< Back Cancel

ﬁ! Setup - Panoramic Dental Imaging had —

Installing
Flease wait while Setup installs Panoramic Dental Imaging on your computer,

Extracting files...
C:'\Program Files (x&5)\Panoramic\priestapp.exe

. Cancel 4

ﬁ! Setup - Panoramic Dental Imaging had —
Completing the Panoramic Dental
Imaging Setup Wizard

Setup has finished installing Panoramic Dental Imaging on your
computer. The application may be launched by selecting the
installed shortcuts,

Click Finish to exit Setup.



http://www.pancorp.com/software/files/PANCORP_DENTAL_IMAGING_9.1.2.7600.exe
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Make sure to use a x16 (4 inch) slot when using the EPIX EB1 card with Windows 10.

L
0]
a—

U

a. Download the EPIX EB1 Drivers.zip and extract the appropriate drivers for your OS version to your desktop.

b. Open the start menu and search “device manager” and click on the “device manager” result.

B L @

Best match /

? Device Manager
2 Control panel

c. Inthe “other devices” category, there may be a device named “Coprocessor” or “PCl device” Right-click on
the device and chose “update driver software”.

v B7 Other devices

Updbte Driveer Softueare.., I
Disable
Uninstall

Scan for hardware changes

im Systemn Properties

i Universar seran ous canroners

>
>
>
> S Storage
>
>


http://www.pancorp.com/software/files/EPIX-APR2017.zip
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d. Click “browse my computer for driver software”.

e. Atthe top click the “browse” button and navigate to the folder on your desktop and click “ok”.

4 B Update Driver Software - Coprocessor

Browse for driver software on your computer

Search for driver software in this location:

!
Cll UsertD t
‘ SUsers\User\Documents Browsse For Folder %

Include subfolders
Select the folder that contains drivers For vour hardware,

- Desktop ~
daa OneDrive
—> Let me pick from a list of dev B User

This list will show installed driver softw v E This PC
software in the same category as the d v [ Desktop

’ Epix -\Win1(x6d
T

port? |5 Docurnents
{ Downloads
J’ Music

W
=

Folder: | Epix -Win 10x64

_>' O% Cancel

f.  Click “next” on the update driver window.

g. If any security box pops up, make sure the “always trust software from “EPIX, inc” is checked and click
“install”.

E=] wvind ows Security x

Would you like to install this device software?

Mame: PIXCI(R) Driver
=27 Publisher: EPIX, Inc.

Iways trust software from "EPLX, Inc.". Il Install |I| Den't Install I

{3) You should enly install driver software from publishers you trust. How can |
decide which device software is safe to install?

h. After it successfully installs the driver click “close” on the update driver window.
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If it says you need to reboot the computer to finish installing the device, click “no” for now.
The capture card should now be under the “imaging devices” category in the device manager.

k. From the drivers folder downloaded, double-click on the “EPIXXCW6_memory_limit” file and click “yes” on

the window that pops up to merge, and “OK”.

@ registry Editor x|

o The keys and values contained in C:\Users\User\Desktop\Epix
~Win 106\ EPLO(CWE_memory_limit.reg have been successfully added to the registry,

0K

RESTART THE COMPUTER
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a. Open the “Panoramic Dental Imaging” software If prompted about Performance optimization click Yes.

Performance optimization

I.-"'_"‘-.I The performance of the software has not yet been optimized for this
' hardware. The optimization process will take less than 30 seconds. Do
you want to perform the optimization now?

b. At the top of the software click “Tools” then “Settings...”
¥ Panoramic Dental Imaging - [Unsaved dataset]
¥ File View Patient Image Tools Window Help
System status His Settings ...

Sengor Mot connected

Dataset tools
Action  |dle 3

DICOM ...

Maintenance *

Mo sensor connected!

Send error report ...

Language > F

c. Click on the “General” tab and select “Ask for patient information after exposure”.

Settings

Grabber] Panoramic unit] TWAIN] Imagel T
Fatient infarmatiar

" Mo patient information

I (* Ask for patient information after exposure

"~ Reguire patient information before exposure

Click on the “Grabber” tab and Ensure the proper preferred grabber is selected (EPIX EB1).

Click the “Panoramic unit” tab and chose your type of x-ray machine from the list. If you have the Intel NIC
card, chose the GLAN version of the machine.

PC1000 CAMERALINK OR PC4000 CAMERALINK

-
Settings

General | Grabber Panoramic unit | TywaIN | m

=8 Panoraric Carporation
i Encompass
PCI000 Carnera Link
PC1000 GLAM
PC4000 Carmera Link.
PC4000 GLAM
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f. Click the “Image tab” and check the options of “Lower right corner” and “L and R markers”.

Settings &

General] Grabbel] Paroramic unit] Twial Tools ] Filez and saving] DICOM ] .&dvanced]

Patient infarmation imprinting | —Image options

" None Iv Center image after exposure

Lower eft corer Mairtain image size in manual fecusing window

< 7

 Lower right cormer I o . L
Maintain grey level in manual focusing windaw

" Bottom center

[ Reset grey level settings when dataset changes
Ot B g il [ Crop hon-radiated regions after exposure
" Mone
[ Show white border horizontal
I (+ L and R markers I
-

Show white border vertical

g. Click the “Files and saving” tab, and select “dataset”, set the “Max repository size” to “20000”, and the “Max
number of images” to “100” (these numbers can be adjusted to fit computer needs).

Settings Y
General] Grabber] Panoramic unit] TWAIN] Image] Toolz DICORM ] Advanced]
[ ata repository uzage D1 ata repositony settings
" Maone

[~ Remove hackuE imaﬁe after save
" Images only Maw repository size [MB) 20000

Max number of images 100

h. Click “ok” on the settings windows to save your settings, if prompted to Reboot your PC, click “yes”.
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a. The calibration files should have been backed up from the previous computer. Copy all files in that folder to

the same location on the new PC.
C:\ProgramData\Ajat\panoramic\calib\

C:\ProgramData\Ajat\panoramic\datastor\

Note: This folder is created automatically after the software has been setup/configured. Make sure to

not copy the folder into itself. Example:

C:\ProgramData\Ajat\panoramic\calib\calib\ (wrong)

b. Power the X-ray machine Off, or ensure the sensor is powered off, wait 5 seconds, and power back On.

c. Verify GREEN CONNECTION status light in the TOP LEFT corner of the software program
800-654-2027 opt. 1 for the Service Dept.

Call Panoramic Support if problematic.

System status
Sensor Connected
Action  |dle (3]

System is ready

Important Note: If the calibration date is older than 2 years, please contact Technical Support or your Local Certified

Technician for recalibration. Panoramic Corporation strongly recommends Recalibration of the X-Ray unit & Software

every 2 years. If you cannot see the Date modified column, then you need to change the view of the folder to Details.

» ThisPC » O5(C:) » ProgramData » Ajat » pancramic » calib

Y
MNarme

|| calib_p_SNAP130-PC-0913-20.dat

|&] calib_p_SMAP150-PC-0913-20.dat.maske...
|&] calib_p_SMAP150-PC-0913-20.dat.prema...
| | calib_p_SMAP150-PC-0913-20.dat.temp
= calib_p_SNAP130-PC-0%13-20.dat.txt

View >
Sort by >
Group by >
Refresh

Customize this folder...

Paste
Paste shortcut

Undo Delete Ctrl+Z
Give access to b
MNew >

Properties

12/
12
12
12/

Date modified
2017 12:07 PM
2017 12:07 PM
F2017 12:07 PM
F2017 12:07 PM
2017 12:07 PM

12/

M OMD D MO | MO

Extra large icons
Large icons
Medium icons
Small icons

List

Details

Tiles

Content

Type

DAT File

PMG File
PMG File
TEMP File

Text Document

Size

12,445 KB
3KB
2KB

12,445 KB
3KB
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a. Ensure the Software direction L/R (top right of screen) matches the Machine direction L/R (side panel)
Machines Encompass, Envision P, and Envision C1 are set to Automatic
A green connection to the software/sensor is required to change this button direction

Envision C1 _\I

Parnoramic unit program

. Automatic

Panoramic unit progran

.. Panoramic L

a. Because this is a new computer the images by default will be very light until adjusted. You can follow the
instructions listed on page 20 of the Guide to getting the best images to adjust the default image
adjustments

How to Correct VERY blurry images from using the wrong direction captured
Only for PC1000 & PC4000 units.

) s v - K o1 Reason for the Problem: The direction of the machine <3 - = B X
% Fle| View Patent Image | Tools| Window Help [pee0n DLINe Lo e - STeix
S5  Opmimmefle~ {  Satngs | capture did not match the Software. Change the buttor, oy, |
Open dataset . in the software by clicking on it, or change the machine 7 o
direction to match. msnt| CRS | oot SO Uve NN

-0

[TO Correct the image to avold a retake: Recover the

image by using the Data repository under the File (1 U || moumes G0N0 B0l B¢ gommed

imenu. Once the poor image is reloaded, then flip the
dataset direction by using the Tools menu.
'You may correct the image first if it is still on the screen

fote/ame: Is-vd[m: |mmbﬂ=m
[2018108/25 10:22:95 ves 072 SKLLL PHANTOM _;

Repostory Lsage: /50 fles, 245/30000 megabytes.

| -

SKULL PHAN


http://www.pancorp.com/images/files/upload/FM_7453_Rev_A-PC4000_troubleshooting_and_Software_Guide.pdf

